Release Notes for Modo 13.0v1

Copyright © 2019 The Foundry Visionmongers Ltd.

Release Date
26 March 2019

System Requirements
Officially Supported Operating Systems
• Mac OS 10.12.x, 10.13.x, and 10.14.x (64-bit only)
• Windows 10 (64-bit only)
• Linux 64-bit operating system (CentOS/RHEL 7+)

Minimum Hardware Requirements
• Intel processor(s), Core i3 or higher
• 1 GB available hard disk space (for Modo installation).
• 6 GB available hard disk space (for full content).
• At least 4 GB RAM
• Display with 1920 x 1080 pixel resolution
• Internet connection for product activation and online videos access
• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of graphics
memory and drivers that support OpenGL 3.2 or higher.

Recommended System Requirements
NOTE: This information is our best recommendation for the average user. Requirements vary by
usage, and individual users may have different requirements from those listed here.
• 2.5+ GHz quad-core processor
• 250+ GB disk space available for caching and temporary files, SSD is preferable
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• 16 GB RAM with additional virtual memory*
• Display with 1920 x 1080 pixel resolution
• An NVIDIA or AMD graphics card with the latest drivers
• 2+ GB of graphics memory
• OpenGL 4.4 or higher support
*The use of virtual memory improves stability and helps prevent data loss on large projects.

Recommended Graphics Driver Versions
• NVIDIA: 419 or later*
• AMD: 8.982.8.1 or later*
*We recommend downloading the latest driver version from the NVIDIA or AMD websites

Tested Workstation Hardware
The configurations listed below are those that Foundry have tested with Modo 12.2v1. Due to the constantly
changing nature and wide variety of computer hardware available in the market, Foundry is unable to officially
certify hardware. The list below can be used as a recommendation and does not guarantee that it meets your
particular needs.
If you encounter any issues, please visit the Support Portal at https://support.foundry.com.
Tested Workstation Hardware
Apple

• MacBook Pro (Retina, 15-inch, Mid-2015)
• iMac (Late 2012)
• Mac Pro (Late 2013)
• MacBook Pro (Mid-2015)

Dell

• XPS 15 9560
• Precision 3520

HP

• HP Z800
• HP Z640
• HP Z600

CPU

• AMD Ryzen Threadripper
• Intel i7-4770k
• Intel i7-7700k
• Intel i7-8700
• Xeon E3-1505M v6
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Tested Workstation Hardware
• Xeon E5504
• Xeon 5620

Tested GPU Hardware
AMD Prosumer Graphics Cards

• Radeon™ Vega RX
• Radeon™ R9 M370X
• Radeon™ Pro WX8200
• Radeon™ Pro WX7100

AMD Enterprise Graphics Cards

• FirePro™ D700

NVIDIA Prosumer Graphics Cards

• GeForce 675MX
• GeForce 970
• GeForce 1050 (laptop)
• GeForce GTX 1070 Ti (Linux)
• GeForce 1080

NVIDIA Enterprise Graphics Cards

• Quadro® K620
• Quadro® M620
• Quadro® M4000

New Features
Animation and Rigging
Animation Layers
Animation Layers allow for nondestructive editing of specific actions. A Layer at the top of the layer stack can
either override or be applied additively on top of preceding animation layers in accordance with our order of
operations deformation system. Layers can be defined as active or muted. They can be soloed for isolation or
locked to prevent accidental editing.
Specific elements can also be masked allowing for combining of multiple separate animations. Layers can be
easily enabled, selected, duplicated, edited, baked and exported, all while maintaining granular control of
authored animation data.
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Automatic Data Type Conversion
Different data types can now be directly connected to each other without the need for additional conversion
nodes. This greatly simplifies rigging and reduces the size of schematic networks.

Blend Falloff
Falloffs can now be combined using the new blend falloff item. Multiple falloffs can be combined and defined by
blending type.

Pattern and IntRange Channel Types
New Pattern and IntRange channel value types have been added to allow you to define a pattern and a range of
integers.

Schematic Improvements
• Disable Link - You can disable links by selecting them and pressing the H key. You can re-enable them using
the U key.
• Node Alignment - You can now align and separate your nodes in various ways using the new node alignment
commands.

Direct Modeling
Edge Bevel Depth Option
You can now control the radius of an Edge Bevel using the Depth option. You can make it inverted, and
anywhere in between.

Edge Relax
The new Edge Relax tool allows you to relax edges perpendicular to the selection. It is useful for changing the
radius of bevels after the fact, creating chamfers from bevels, and welding overlapping vertices. These
alterations would otherwise require time-consuming point-by-point alterations.

Find Shortest Path Selection
This selection tool automatically finds the shortest selection path between two manually defined selected
elements. It also works on UVs.
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Ground Align
The Ground Align tool aligns any geometry in a selected layer to the Work Plane. You can drop items to the
ground, or select a vertex, edge, or polygon, and rotate the item so that the selection is aligned to the ground.
You can also drop items to the origin.

Linear Falloff - Align to Selection Bounding Box
Falloffs that are part of a tool preset now automatically align to the selection bounding box orientation.

Quick Align
The Quick Align tool allows you to quickly move and orient a selection based on other geometry in the scene.

Replicator - Base Scale Channel
For Replicator items, you can set the base scale of the original item. This allows you to set randomly scaled
replicas to be either all bigger or all smaller than the original.

File I/O
Unity Bridge
The Unity Bridge plugin uses a network connection to send, create, and update geometry, material, texture, and
camera data dynamically from Modo to Unity and from Unity to Modo.

MeshFusion
Fusing by Selection Set
You can now use polygon selection sets to specify which parts of a mesh will interact with MeshFusion. You can
use the following three selection sets:
• Fusion! - Designates which polygons of a MeshFusion Source Mesh will be included in MeshFusion's boolean
operations.
• Fusion+ - Marks polygons to be used by MeshFusion.
• Fusion- - Marks polygons to be excluded from MeshFusion completely.
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Zero Level of Subdivision Option
Generally, MeshFusion uses two levels of subdivision by default. This is required by certain topologies, such as
triangles, n-gons, and vertices with three edges converging on them. If your source mesh was already quite
dense to start with, this can cause problems.
You can now use a subdivision level of 0 for Fusion meshes.

Procedural Modeling
Arrays
Arrays are a multi-dimensional value type that can store multiple values of different types in a single value. They
can take any value type supported by Modo, such as integer, float, and matrix. However, all values within the
array should be of the same type.
A number of Array modifiers have been introduced that you can use to create and manipulate arrays:
• Array Blend
• Array Count
• Array Element by Index
• Array Element Type
• Array Operator
• Curves to Array
• Filter Array
• Locators to Array
• Merge Arrays
• Mesh Data Array
• Offset Array
• Particles to Array
• Sort Array
• String to Array

Create Polygons
The Create Polygons mesh operation generates new polygons and vertices on a procedural mesh layer, using
arrays of position values. It allows you to create both surface-type (Face, Subdivision, Catmull-Clark) and lineartype polygons, such as curves and lines.
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Curve to Bezier
The Curve to Bezier mesh operation is a specialized operation that allows you to convert an existing curve to a
Bezier curve. The normals used to create the Bezier tangents usually come from an array generated using the
Mesh Data Array, but you can use any valid vector array input.

Edge Bevel Depth Option
You can now control the radius of a procedural Edge Bevel using the Depth option. You can make it inverted,
and anywhere in between.

Edge Relax Mesh Operation
The new Edge Relax mesh operation allows you to procedurally relax edges perpendicular to the selection. It is
useful for changing the radius of bevels after the fact, creating chamfers from bevels, and welding overlapping
verts. These alterations would otherwise require time-consuming point-by-point alterations.

Merge Meshes Particle Support
The Merge Meshes operation now supports particles as input.

Select by Pattern
The Select by Pattern selection operation creates a selection based on a pattern you define. The pattern
selection specifies elements using a "True, False" pattern. Elements whose index is present in the pattern are
selected. For example, the pattern "True, False" selects every other element, whereas the pattern "False, False,
True" selects every third element.

Smooth Mesh Operation - Preserve Volume Option
The Preserve Volume option has been added to the procedural version of the Smooth tool. Previously this
option was only available for the direct modeling version.
This option allows you to maintain some of the definition of the original object by preserving object volume.

Spike Mesh Operation
A procedural version of the Spikey tool has been added.

Switch Modifier
The Switch modifier allows you to connect multiple inputs to a single connection, and use an index channel to
specify which of the inputs is written to the output. It works similarly to the String and Numeric Switch modifiers,
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but it can operate on any value type.

Rendering
AMD Denoiser
You can now use AMD's hardware-agnostic denoiser for denoising render outputs. This provides additional
options to reduce render times. The options available are Wavelet, Bilateral, and Median.

AMD Radeon™ ProRender
AMD’s GPU accelerated path-tracer, the Radeon Pro Render is now a part of Modo’s collection of powerful
rendering options.

Material Presets
Material Presets are collapsed, complete materials that can be leveraged for cleaner display of materials in the
Shader Tree. If a Material Preset in the browser has had any properties changed, these changes automatically
populate to the reference in the Shader Tree. In a large team environment, this can be significantly important in
maintaining consistent material use across many Modo scene files.
Material Presets can also be unlocked and expanded, allowing for traditional editing of the preset material within
the Shader Tree.

NVIDIA® OptiX™ Denoiser Updates
You can now denoise any number of render outputs with the NVIDIA OptiX Denoiser.

UI
Drag and Drop Scenes from the Preset Browser
Entire scenes can now be loaded from the preset browser. Furthermore, scenes can be loaded into an
independent scene, added to an existing scene, loaded as a reference or as a proxy item.

Modo Layout Improvements
• A Groups viewport filtered on Render Passes has been added to the Passes viewport in the Modo layout
along with buttons for adding and removing channels from the Pass.
• Tool Properties - There is a new preference setting to choose how tool properties are displayed in the Modo
layout. By default, a button below each toolbar opens a popover form. You can change this in the UI
Preferences to display the tool properties in line below the toolbars. The Inline option is intended for larger
screen sizes where there is sufficient room to display the properties without excessive scrolling.
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UVing
Edge and Vertex Slide to Work in UV Context
Edge and Vertex Slide can now both be leveraged inside the UV window and are available as procedural UV
modifiers.

Show Wireframe Option in UV Viewport
Wireframe display can now be toggled in the UV viewport, making visualization of dense meshes easier to read
when features like UV distortion are enabled.

UV Cut Map
The new UV Cut Map tool allows you to define sets of selections that are color-coded and displayed on the
model in the 3D viewport. The Unwrap tool can also be run automatically from the UV Cut Map form and the
Unwrap tool itself can now leverage Cut Maps and selection-sets from within its tool properties.

UV Pack by Item
Packing can now be defined on an item-per-UDIM basis. This makes producing complex UV sets easier as well
as offering a way to more easily manage unwrapping and editing multiple items at once.

UV Split to Respect Connect To Options
The UV Split tool has been enhanced to include options to define the direction of a split edge.

Feature Enhancements
• BUG ID 372315 - The Cylinder primitive's default Segment count has been changed from 12 to 1. This
reduces the amount of additional changes you need to make when using the primitive.
• BUG ID 376681 - Windows only: The built-in Solidworks importer plug-in has been updated to the 2019
version.
• BUG ID 379242 - Viewports: AVP/VR - supportedgfx string has been added for Radeon 19.Q1 Pro drivers,
enabling threaded rendering on AMD with compatible drivers.
• BUG ID 379709 - Rendering: Update to OptiX 6.0 libraries, fixing crash on Linux. This version also takes
advantage of Tensor Cores present on Volta and Turing GPUs to accelerate the OptiX AI Denoiser. Minimum
driver required is 418.81 on Windows and 418.30 on Linux.

Bug Fixes
• BUG ID 230380 (52817) - File I/O: Exporting to MDD did not clear the used RAM.
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• BUG ID 251434 - VR: Using threaded rendering on AMD Radeon drivers 18.12.3 (18.50) caused the drivers
to crash.
• BUG ID 273003 (54869) - Viewports: Setting a layer to Bump in a specific scene caused Modo to crash.
• BUG ID 279850 (55647) - Viewports: In the Advanced viewport, wireframe was not visible on polygons with
flat UVs and normal map texture.
• BUG ID 288704 (41852) - Presets: The Lock Preset Thumbnails preference was not working.
• BUG ID 293817 (55415) - Viewports: The Dimensions tool didn't update in component selection mode with
mesh operations.
• BUG ID 337838 (57893) - Viewports: Cameras and some lights were drawn with missing lines in the viewport.
• BUG ID 340514 (58145) - Procedurals: Edge selections were lost after using Vertex Bevel.
• BUG ID 340515 (58158) - Viewports: Selecting an n-gon with high edge count with Show Selection Normals
enabled in the viewport caused Modo to slow down.
• BUG ID 343608 (58304) - Modeling: A morph created from a Background Object didn't respond to tools with
Selection Falloffs.
• BUG ID 354016 - UI: The Preview viewport did not have Minimize/Maximize controls.
• BUG ID 356601 - Viewports: In the Advanced viewport, partially transparent meshes were drawn over the top
of solid meshes.
• BUG ID 358492 (58786) - Schematic: Buttons were sometimes obscured or cut off by viewport navigation
icons.
• BUG ID 358666 - VR: Certain file names did not display as expected in VR dialogs.
• BUG ID 361050 (58890) - Animation: Animation playback used an excessive amount of memory due to
dynamics.
• BUG ID 361872 - Modeling: The Vertex Slide tool did not support closed-line polygons properly.
• BUG ID 364399 - MeshFusion: Some Airtight Final meshes had holes in them.
• BUG ID 366707 - Viewports: A specific scene used in the default viewport caused Modo to crash.
• BUG ID 370160 - MeshFusion: When duplicating a source mesh as a normal non-Fusion item, it was not autoselected.
• BUG ID 370268 - Schematic: Right-clicking two selected links in the Schematic caused Python errors.
• BUG ID 370937 - Topology: Using the Topology Pen sometimes caused Modo to crash.
• BUG ID 371036 - Procedurals: Setting a curve as its own source for the Curve Clone mesh operation caused
Modo to crash.
• BUG ID 371240 (59151) - Presets: Locked material presets couldn't be deleted.
• BUG ID 371491 (59162) - Procedurals: Clicking on a new mesh item did not deselect the current mesh
operation.
• BUG ID 371807 - Viewports: Swapping between foreground and background layers with Independent
Drawing enabled didn't update wireframe drawing.
• BUG ID 371961 - Modeling (Linux only): Right-clicking on the Tube Primitive tool caused Modo to crash.
• BUG ID 372010 (59168) - Viewports: Enabling Show Vertex Normals caused lag in the viewport.
• BUG ID 372019 - Viewports: Hiding deformed meshes impacted performance.
• BUG ID 372132 - UI: The icons for Particle Paint and Mask were incorrect.
• BUG ID 372292 - Shader Tree: Loading a scene with circular dependencies in the Shader Tree instances
caused Modo to crash.
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• BUG ID 372485 - Schematic: Draging the Comment channel onto the schematic Comment node caused
Modo to crash.
• BUG ID 372883 - UV: In certain scenes, UV Rectangle did not work as expected.
• BUG ID 372884 (59179) - Procedurals: Linking a zero-value distance user channel into the Curve Rebuild
mesh operation caused Modo to become unresponsive.
• BUG ID 372886 (59181) - Procedurals: The Vertex Bevel operation did not detect new vertices using the
Select by Previous operation.
• BUG ID 372887 (59182) - Procedurals: In certain scenes, Curve Rebuild did not work as expected.
• BUG ID 373686 - Rendering: Enabling the NVIDIA OptiX denosier on the master system caused Modo to
crash on slave systems.
• BUG ID 373987 (59214) - Modeling: Component selection was slower than expected.
• BUG ID 374331 - Procedurals: It was not possible to define the path for presets in the stitch mesh setup
command.
• BUG ID 374474 Modeling: The Round Level for the Edge Bevel operation could be set to negative values,
which did not produce any result.
• BUG ID 374523 (59219) - UV: The Export to UVs from Texture menu did not work when using the Create UV
Map mesh operation.
• BUG ID 374658 - Procedurals: Stitch Mesh Setup left background constraint active.
• BUG ID 375202 - Modeling: Clicking the menu bar command Select > Selection Commands > Boundary
with a hidden locked mesh in the scene caused Modo to crash.
• BUG ID 375553 (59236) - Procedurals: The Axis Slice mesh operation did not ignore Text polygons.
• BUG ID 375613 (59237) - Viewports: When selecting multiple hidden items in component selection mode, they
were not displayed in the viewport.
• BUG ID 375798 - Modeling/Procedurals: Using Edge Split sometimes caused Modo to crash.
• BUG ID 375933 (59242) - Schematic: Dragging a Backdrop from one Workspace to another did not display
the Backdrop's contents.
• BUG ID 375945 - UI: Locator was missing from the Add >Locators menu in the Items list.
• BUG ID 376227 - Modeling: The Jitter tool split UVs.
• BUG ID 376412 - Procedurals: Grow/Shrink operations on a Polygon Bevel sometimes caused Modo to
become unresponsive.
• BUG ID 376435 (59259) - UI: In the Modo layout, the Edit > Subdivide > Options dialog tooltips were
incorrect.
• BUG ID 376436 (59260) - Procedurals: The Transform UV Map mesh operation was in the wrong Preset
Browser category.
• BUG ID 376710 (59272) - Baking: Dithering for 'shade.normal' render output and baking to textures for integer
formats was not implemented.
• BUG ID 376837 - Shader Tree: Changing the type of shading items to Texture Layers did not automatically
create Texture Locators.
• BUG ID 377013 (59298) - Modeling: The Edge Bevel offset position on round edges was incorrect.
• BUG ID 377071 (59307) - Procedurals: The Clone mesh operation cloned the whole curve in vertex mode,
when used with a selection set.
• BUG ID 377073 (59309) - Particles: The Particle Look At into Replicator was missing a single replicated mesh.
• BUG ID 377451 - Animation: When working with Animation Layers, unmasking selected items didn't work.
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• BUG ID 377488 (59319) - Schematic: Creating a new Comment node kept the old one selected.
• BUG ID 377494 (59321) - Procedurals: Vertex Bevel did not round the vertices as expected.
• BUG ID 377690 (59336) - Schematic: Backdrops were lost when moved between assemblies.
• BUG ID 377691 (59337) - Schematic: When moving Comment nodes from one Assembly to another, the
comment text field was lost.
• BUG ID 378039 - Modeling: Using the Arc tool to snap the angle at 180 degrees with Snapping enabled,
collapsed the arc into a line.
• BUG ID 378077 - Customization: Opening some of the SLIK 2 Preset Browsers caused Modo to crash.
• BUG ID 378098 (59345) - Procedurals: Animating a group locator containing a curve used for the Stitch Mesh
Item did not work as expected.
• BUG ID 378101 - Procedurals: The Assign Selection Set operation on a mesh corrupts UVs when it's
merged into another mesh.
• BUG ID 378316 - Scripting: Executing certain tool commands in a recorded macro that has been stored in a
configuration file failed to execute.
• BUG ID 378712 - Procedurals: Moving the mesh or manipulating the mesh operations in a specific scene
caused Modo to crash.
• BUG ID 378762 (59357) - Shader Tree: Adding a Vertex Map texture automatically created a weight map.
• BUG ID 378765 (59360) - Modeling: Snapping did not work with Polygon Extrude.
• BUG ID 378773 (59368) - Procedurals: Using Holes with the Stitch tool do not follow the animation.
• BUG ID 378855 - MeshFusion: Enabling then disabling Strip Polys Only in a specific scene caused Modo to
crash.
• BUG ID 378919 - Schematic: Backdrops did not auto-expand to accommodate their child node heights.
• BUG ID 379129 - MeshFusion: Using subtractive trims in a specific scene caused Modo to crash.
• BUG ID 379293 - Modeling: Using Polystein Mesh Paint caused Modo to crash.
• BUG ID 379497 - Modeling: Freezing an SDS mesh in cage mode triangulated the result.
• BUG ID 379631 (59389) - Schematic: Exposed input links of an Assembly did not display tooltips if a Backdrop
was present in the background.
• BUG ID 379936 (59405) - Modeling/Procedurals: Edge Split didn't split edges to the geometry borders.
• BUG ID 380566 (59424) - Schematic: Add Node with a link selected did not work as expected.
• BUG ID 380746 (59431) - Schematic: Connecting a node to an elbow moved other connections and left invalid
connections.
• BUG ID 380911 (59433) - Schematic: Inserting a channel modifier did not work correctly for links with elbows.
• BUG ID 380970 - UVing: The Tear Off UVs setting for the Quick Align tool changed state when moving the
cursor from a UV viewport over another GL viewport in the process of changing settings.
• BUG ID 381191 (59437) Scripting: schematic.insertLink did not support elbowGraph links as a link argument.
• BUG ID 381434 - File I/O: Sending a static mesh actor from Unreal to Modo and back to Unreal using the
Unreal Bridge did not retain the material connections in Unreal.
• BUG ID 381882 (59457) - Procedurals: Edge Bevel did not preserve the material assignment on either side of
the beveled edge.
• BUG ID 382108 - Modeling: Moving the Arc tool's radius handle through the center point collapsed it to a line.
• BUG ID 382833 (59467) - Procedurals: Playing the animation of a mesh operation rig in a specific scene used
an excessive amount of RAM.
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• BUG ID 382836 - UI: In the Modo layout, the Time button appeared collapsed on smaller screen resolutions.
• BUG ID 383078 - Customization: Launching Modo when a specific configuration is loaded with a Preset
Browser open caused Modo to crash.
• The Unreal Bridge UI was not client-agnostic.
• ToolChoices did not properly return the help for the current choice if the sheet hash didn't resolve to a key.

Known Issues and Workarounds Specific to this Release
This section covers known issues and gives workarounds for them, where appropriate.
NOTE: Due to internal bug-logging and tracking process improvements, new bug identification
numbers are used, with the legacy IDs provided in parentheses, where appropriate.

Animation
• BUG ID 240321 (53661) - Selecting actions does not always select the correct one. This is caused by copying
actions.
As a workaround, manually edit the tags on the broken actions by selecting them in the Groups tab, then save
and reload the scene.

Assemblies
• BUG ID 288164 (36452) - Assemblies exported from the Item List context menu result in poor visual layout of
nodes on import.
As a workaround, you can save assemblies from the Schematic viewport.

Baking
• BUG ID 293020 (50671) - Baking displacement maps can cause UV seams to be visible, and the baked
displacement map to show quilting effects and other render artifacts.
• BUG ID 221481 (49437) - The Bake Channel Swizzling option can’t bake to texture alpha.
• BUG ID

Bucket Render
• BUG ID 297021 (52730) - The Vertex Illumination Bake command doesn't work as expected, when the mesh
has transform channels.
As a workaround, freeze the transforms in the mesh properties.
• BUG ID 292947 (53184) - Value presets created for material Subsurface Scattering samples in Modo 10.1 or
earlier now show on the render item instead.
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• BUG ID 279848 (55663) - Motion Blur applied on a curve in a mesh operation no longer works.
• BUG ID 243070 (53793) - Rendering using a Dual CPU with 72 threads was significantly slower than
expected.
As a workaround, any machine that has more than 32 cores, performance will be better if you limit rendering to
half the number of cores you have.
• BUG ID 235368 (53411) - Mesh lights or any direct light too close to a surface can produce fireflies (hot pixels)
in some cases.
As a workaround, use a Maximum Radiance higher than 1 W/srm2 to reduce the bias.

Color Management
• BUG ID 221439 (49244) - (Windows only): With Perform Color Correction on, setting a default scene to a
scene with a mesh that has a position channel crashes Modo at launch.
As a workaround, use System > Reset Preferences to reset to defaults or move/remove the default scene.

Command Line
• BUG ID 289290 (49514) - macOS X only: Running modo_cl before running the UI Modo application breaks
code signing.
As a workaround, start the UI version of Modo once, before running modo_cl on any system where you later
intend to use the UI version.

File and Image I/O
• BUG ID 337523 (56862) - Modo for SolidWorks Kit: Modo crashes when importing the same SolidWorks file
twice in one Modo session. This bug only affects import using the kit, not direct imports (File > Import).
As a workaround: Before importing a SolidWorks file for the second time, exit and restart Modo.
• BUG ID 221508 (50198) - Alembic scenes don't export some surface items, including static meshes and
procedural shatter items.
• BUG ID 226589 (49728) - Exporting selected layers (from the Item List context menu) to .fbx doesn't export
instances, unless the original mesh is also exported.
To resolve this, set the .fbx preference to Export Selection and use Export As….
• BUG ID 220991 (47036) - Color management in .svg images is not currently supported. This is a side-effect of
a bug fix where the largest allowable image size (64k x 64k) was always used when color correction was
enabled.
• BUG ID 220975 (46962) - Rendering .svg images used as stencil maps for displacement or for layer masking
can be very slow.
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Fur
• BUG ID 288248 (35731) - Fur length textures can’t be edited with the Stretch tool.
As a workaround, use different fur length drivers, such as hair guides or vector vertex maps.

Input Devices
• BUG ID 303287 (35856) - Linux only: Plugging in a Wacom tablet while [[[Undefined variable Modo_
Variables.Product]]] is running can cause undesired movement. This cannot be fixed, due to a limitation of the
hardware driver.
To avoid this, plug in the tablet before application start-up or restart.
• BUG ID 226536 (51741) - Mac OS X only: Modo sometimes becomes unresponsive when using the
combination of a click-drag in a tree view (for example, when toggling the visibility of two successive items in
the Shader Tree), followed immediately by a two-finger scroll gesture on some devices, including laptop
trackpads and the Magic Mouse.
As a workaround, change to a 3-button mouse (recommended to fully access all of Modo's features).

MeshFusion
• BUG ID 316276 (56973) - If a Trim Fusion role is assigned to an object and then it is dragged and dropped onto
a Primary, the drop menu does not contain the Trim boolean options.
As a workaround, use either the Fusion buttons (Tool palette - Set Mesh Role & Apply section) or Pie Menu
(Apply Subtraction or Apply Intersection) when initially adding Trims to each Fusion Item (Trims can
contribute to multiple Fusion Items). If initially applied with either of those methods, all subsequent Drag &
Drop options will be supported.

Modeling
• BUG ID 226970 (32728) - Zooming out with a Space Navigator alters the Work Plane position.

Network Rendering
• BUG ID 226363 (48325) - Scenes with image sequences rendered with Full Frames use the wrong image
sequence number on slave machines.
As a workaround, use File > Consolidate Scene, then render the scene using a shared network folder
(Preferences option under Rendering > Network Rendering).
• BUG ID 226337 (36986) - Slaves render hidden meshes. Since mesh hide state is not stored in the scene,
when that scene is transferred to the slaves, the state is lost. The master respects the hidden state, however.
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As a workaround, if the intent is to avoid rendering, toggle the visibility for the item or render or open System >
Preferences > Rendering and disable Use Network Render Nodes.
• BUG ID 226336 (25636) - Frame passes are not supported.
• BUG ID 220955 (30318) - Network Rendering doesn’t support Realflow particles.
• Several Bugs - While it apparently worked in Modo 902, in some cases, Network Rendering was not
implemented to support baking. Changes to Modo in the 10-series apparently broke what was working for
some artists, so the functionality has been disabled.
As a workaround, Modo 10 implemented the ability to Network Bake using Bake Items and an external render
controller. For more information, please see the SDK Wiki.

Nodal Shading
• BUG ID 221393 (50642) - Nodal shading does not support UDIMs.
• BUG ID BUG ID 385250 - Nodal Shading is slower in 13.0 with some modifiers.

Painting/Sculpting
• BUG ID 288461 (41682) - Textures are not always updating in Preview/Render when painting on an image
map.
You can save and reload the image to force the update.

Particles
• BUG ID 303192 (34925) - Re-opening scenes saved with large particle caches can cause problems.
To avoid such issues, delete the cache before closing Modo, or export the particles to .csv cache files or
Realflow .bin files. You can do this by attaching one of those nodes to the Particle Simulation item in the
Schematic viewport, and clicking Cache Simulation.

Preview
• If a high poly mesh is not visible, the Preview baking output will be incorrect.
As a workaround, reset Preview to fix the baking.

Procedurals
• BUG ID 305303 (56318) - Procedural duplication of mesh operations in a Deform folder creates errant Mesh
Ops list.
• BUG ID 305302 (56317) - Duplicating procedurals does not work with the Select By Previous Operation tool.
As a workaround, manually edit the duplicate's Select By Previous Operation Mesh Ops.
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• BUG ID 289810 (46512) - When rigged, Rock items and other procedurals do not display correctly in GL. This
is a limitation of the feature and will not be fixed.
You can use Preview or RayGL to visualize the variations from rigging.
• BUG ID 266469 (54738) - A duplication of any item that is a Merge Meshes source (for example, a mesh item,
procedural item, or Fusion Item), any duplicates (duplicate or instance) are added to the Merge Meshes Ops
List as a source.
As a workaround, remove the unwanted additional Merge Mesh sources (regardless of the type of source) in
the Mesh Ops List using the X button next to each Merge Meshes source.
• BUG ID 221355 (52149) - Curve Extrude mesh operation: The Path Segment Generator's Align to Normal
option doesn't work when using a Bezier with zero-length tangents.
As a workaround, rotate the polygons to point toward the +Z before extruding or make sure there are no zerolength tangents.

References
• BUG ID 294394 (44492) - If a scene that already contains references is referenced, the shading of the original
references may not persist.
As a workaround, limit scenes with shading to one level of reference.
• BUG ID 220957 (41119) - Reloading a reference after replacing it with the same file can cause Modo to crash.
• BUG ID 309252 (56620) - Modo crashes when closing a scene containing a referenced scene after attempting
to revert a reference override.
As a workaround, first close and reopen the scene before attempting to revert the reference.

Rigging
• BUG ID 287584 (27244) - Duplicating joints in a bound mesh retains influences from the original joint chain.

Scripting
• BUG ID 242545 (53458) - Right-clicking or running a script in the Script Editor can lock up input to Modo.
As a workaround, click in the top window of the Script Editor, use the main menus, or change to another
application, then switch back to Modo.

Shader Tree
• Unreported: Material Preset References: Material Preset References may not always show the correct preset
as selected in the item properties. You should look at the filepath channel in the Channels list to find out which
preset file a material preset item is referencing.
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• BUG ID 336112 (57874) - Custom Materials that define their own smoothing properties (such as the Skin
material), no longer smooth the mesh correctly.
• BUG ID 299187 (37858) - In the Shader Tree, choosing a group from Add Layer > Image Map > (use clip
browser) fails.
To work around this issue, in the Clip Browser, choose a single image instead of the group, and then change
to the image group using the Texture Layer's Properties tab.
• BUG ID 288141 (30947) - Layer masking displacement does not work unless you drag and drop the masking
layer onto the displacement layer.

Unreal and Unity Materials
• BUG ID 295862 (50700) - There is no way to visualize the Unreal SubSurface Color effect in Modo.
• BUG ID 294747 (50701) - Unreal material Ambient Occlusion does not bake correctly in Modo.
• BUG ID 221477 (50451) - On some graphics cards, Unity material may cause flickering in the Advanced
viewport when used with bump maps and shadows.

UI
• BUG ID 333249 (57715) - Selecting items in the viewport does not always update the Properties form.
As a workaround, press the Alt key.
• BUG ID 288714 (43162) - Windows only: Setting a custom text size affects Modo's text drawing.
As a workaround, go to the compatibility settings by right-clicking the Modo shortcut or executable, and turn off
font-scaling for the application.
• BUG ID 281374 (55759) - Transforming objects can cause the Items Properties panel to flicker.
• BUG ID 277244 (55571) - Resizing the dopesheet in Zen crashes Modo 11.1, but not in Modo 11.0.
• BUG ID 273139 (55185) - Text in the viewport icon buttons is not visible in the Advanced viewport on some
macOS/AMD configurations.
As a workaround: Upgrade macOS to 10.12 or 10.13.
• BUG ID 226492 (44496) - macOS X only: Disabling Affect System Color Dialog in Preferences > Rendering
> Color Management, and using the system color picker caused colors to darken with each use of the color
picker.
This is due to an OS X issue, which requires the color profile in both the monitor settings and color picker to be
set to sRGB IEC61966-2.1.
• BUG ID 224169 (44896) - Dragging and dropping an image from disk into the Clips list doesn’t work.
If the Clips list is empty, drop the image onto the bar at the top, otherwise drop it above or below other images
in the list.

RELEASE NOTES
18

Release Notes for Modo 13.0v1 |

Viewports
• Windows only: Using Raptr can cause GL driver crashes in Modo.
• RGBA textures only draw correctly in the Advanced viewport. In the Default viewport, any unsupported
texture effect on an image map is drawn as diffuse color when the layer is selected in the Shader Tree.
• BUG ID 338599 (57955) - Clicking on the VR layout tab may crash when using a system with a Radeon WXseries graphics card. This is due to a driver bug and should be fixed by a AMD in a future driver release.
• BUG ID 338374 (58003) - Game Navigation mode (camera rotation) does not work in a floating 3D view
(palette or separate window).
As a workaround, use Game Navigation mode only in docked 3D views (views that are part of a Layout).
• BUG ID 310930 (56706) - Unity and Unreal materials are not displayed correctly when first loaded into the
Advanced viewport.
As a workaround, enable and then disable the visibility of the Shader Tree textures.
• BUG ID 296123 (46995) - Ambient Occlusion display in the Advanced viewport is affected by selected item
wireframes.
You can disable Show Selection in the Visibility options or disable wireframe drawing on the active mesh
layers.
• BUG ID 289738 (49473) - Projections are incorrect if the projecting camera is set to Vertical film fit mode and
the width is less than the height.
• BUG ID 289020 (43771) - Camera projections from non-render cameras show distortion in GL and baking.
To avoid this, make sure that the projection camera has a film width-to-height ratio that matches the main
render camera.
• BUG ID 281365 (55816) - Wireframes are washed out on transparent surfaces in the Advanced viewport.
As a workaround, avoid transparency when modeling or doing work where wireframes are needed.
Alternatively, use the Default viewport.

Developer Notes
• BUG ID 377957 (59342) SDK: Clearing the RenderCache caused Modo to crash.
• RayPak_HitClosest has been changed to set the hit mesh to the element owner instead of using the
result.mesh. They are usually the same, but when a background mesh obscures a hit element on the
foreground mesh, they may not match.
• The PositionData user class has been created, which has easy functions for computing the centroid and
normal axis of a set of 2d/3d positions. Various plug-ins have been updated to use the user class.
• The ILxValue interface has been extended to allow clients to query the name of a value type server from the
server (TypeName). The internal and SDK Value servers have been updated to return a TypeName. The
Value COM interface has been versioned for legacy plug-ins.
• Channel modifiers using ILxChannelModifier::ReadInputValByIndex returned an empty uninitialized value.
• A new server type called ILxValueConversion has been implemented. This is used to convert from one value
type to another during modifier evaluation. The code that checks for compatible channels to see if a valid
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ValueConversion server exists has been modified. If it does, it allows the two channel types to be connected
with a channel link. The channel link modifier has been updated to use a ValueConversion server for
converting between channel types if they are incompatible.
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